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1 Introduction

This document describes how to get BioTac data through a Cheetah SPI Host Adapter
(Total Phase, Inc.). Some functions therefore use Cheetah API functions. Please refer to
Cheetah SPI Host Adapter Datasheet for more details.

BioTac C Library for Cheetah is supported on Linux, Mac OS X, and Windows operating

systems. The current Windows version has some restrictions (discussed in Windows
section), and we recommend that a user test this on Linux (or Mac OS X).

2 General Data Types

The Cheetah API provides the following data types:

typedef unsigned char u08;
typedef unsigned short ulo6;
typedef unsigned int u32;
typedef unsigned long long u64d;
typedef signed char s08;
typedef signed short sl6;
typedef signed int s32;
typedef signed long long s64;

Along with these definitions, BioTac C Library for Cheetah provides the following data
types:

typedef int BioTac;
typedef int BOOL;

as well as structures related to BioTac info (bt _info), properties (bt property), and
data (bt_data) as illustrated in Figure 1.
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[struct bt_info |——— int spi_clock speed |
—{ int number_of _biotacs |

—‘ int sample_rate_Hz |

— struct frame - int frame_type

~|int frame_size

—{ struct batch I—{ int batch_frame_count

|
|
% int frame_structure[] |
|
|

- int batch_ms

|struct bt_property |——— u08 flex_version[] |

ﬂ u08 software_version[] |

% u08 serial_numberf(] |

*I union cpu_speed |—| ulé6 value \

| u08 byte[] |
-~ BOOL bt_connected |

|struct bt_data|———— double time
| double frame_index

|

|

— double batch_index |

| u08 channel_id[] |

1 union d[] - ul6 word |
‘ |u08 byte[] |

{108 parity_check[] ]

Figure 1: Structures and their member variables of BioTac info, properties, and data.
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3 Functions

Initialize Cheetah SPI Device (bt_cheetah_initialize)
Cheetah bt cheetah initialize (const bt info *biotac);

Open a connection to the Cheetah device and return a Cheetah handle to check errors.

Arguments
biotac pointer to a BioTac information structure

Return Value
This function returns a Cheetah handle, which is guaranteed to be greater than zero if valid.

Specific Error Codes
CH UNABLE TO OPEN

The specified port is not connected to a Cheetah device or the port is already in use.
CH_INCOMPATIBLE_DEVICE

There is a version mismatch between the DLL and the hardware. The DLL is not of a sufficient
version for interoperability with the hardware version or vice versa. See ch_open_ext () in
the Cheetah Datasheet for more information.

Details
This function may be used to initialize a Cheetah device to communicate with a BioTac. It configures
SPI subsystems, sets a clock speed, and clears up the batch queue.

Get BioTac Properties (bt_cheetah_get_properties)
BioTac bt cheetah get properties ( Cheetah ch handle,
int bt select,
bt property *property);

Receive and print the properties of a selected BioTac.

Arguments
ch _handle handle of a Cheetah adapter
bt select switch to choose a specific BioTac (i.e., 1, 2, ...)
property pointer to a BioTac property structure

Return Value
This function returns a BioTac error code, which is zero if valid.

Specific Error Codes
BT WRONG NUMBER ASSIGNED

The assigned number exceeds the range, and there is no BioTac assigned to the number.
BT ERROR_UNKNOWN COMMAND

No such command exists. Current version of the BioTac firmware only supports six kinds of
properties: Flex version, Firmware version, Serial Number, CPU speed, Sampling speed, and
Sampling Pattern.
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Details
This function receives and prints BioTac properties such flex circuit version, firmware version, serial
number, and CPU speed, and stores those property data in property (the third argument of the
function).

Configure batch command (bt_cheetah_configure_batch)

BioTac bt cheetah configure batch ( Cheetah ch handle,
bt info *biotac,
int num_samples) ;

Configure a batch of commands.

Arguments
ch_handle handle of a Cheetah adapter
biotac pointer to a BioTac information structure
num_samples total number of samples

Return Value
This function returns a BioTac error code, which is zero if valid.

Specific Error Codes
BT DATA SIZE TOO SMALL
A value assigned to length_of_data_in_second is too small. The value should not be smaller
than batch_ms that is 50ms by default.

Details
This function creates a batch of commands that is constructed by a repeated sampling frame. The
function uses batch frame count,amembervariable of bt info, to setup the number of
frames in a batch. A sampling frame is composed sequentially in the order addressed by
frame structure[]. By default, the following 44 sampling commands generate the frame
structure:

(BT FRAME STRUCTURE DEFAULT): E1l, Pac, E2, Pac, E3, Pac, E4, Pac, E5, Pac, E6, Pac, E7, Pac,

E8, Pac, E9, Pac, E10, Pac, E11, Pac, E12, Pac, E13, Pac, E14, Pac, E15, Pac, E16, Pac, E17, Pac, E18,
Pac, E19, Pac, Pdc, Pac, Tac, Pac, Tdc, and Pac.

Configure save-buffer (bt_configure_save_buffer)
bt data* bt configure save buffer (int num samples) ;
Configure a buffer to save data in a file.

Arguments
num_samples total number of samples

Return Value
This function returns a pointer to a BioTac data structure.
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Specific Error Codes
None.

Details
This function allocates memory for a buffer to store BioTac data and write them in a file later. The
function uses the number of samples, which is calculated from length of data in second.
The function has to be called when the save buffer size is changed.

Collect Data (bt_cheetah_collect_batch)

void bt cheetah collect batch ( Cheetah ch handle,
const bt info *biotac,
bt data *data,
BOOL print flag);

Collect BioTac sampling data in batch unit.

Arguments
ch_handle handle of a Cheetah adapter
biotac pointer to a BioTac information structure
data pointer to data array for storing BioTac sampling data
print flag flag for printing data on Terminal (Linux) or Command Prompt (Windows)

Return Value
This function does not return any value, but stores datainthe bt _data array.

Specific Error Codes
None.

Details
This function collects a batch of data from a Cheetah SPI device and submits a batch of commands
that is configured inthe bt _cheetah get properties function.

By default, a batch contains 5 frames of raw data (ranging from 0 to 4095) and these data will be
decoded in this function. If the result of parity check is wrong, bt _parity will be set to 1.

Currently, elapsed time is set to zero for all data by default (DEFAULT TIMER). If the user is willing
to use a timer provided by your computer, MACHINE TIMER could be enabled (located at the
beginning of biotac. c). This feature is currently experimental.

Note: Cheetah SPI device controls the sampling time according to the commands in the memory. By
default, the interval timing for each sample of channel is 227us periodically. However, collecting
data would occur only after the Cheetah SPI device has finished collecting a batch of data, which is
equal to 50ms of data.
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Print Error (bt_display_errors)
void bt display errors (BioTac bt err code);

Print an error message on the display based on the error code collected inbt cheetah setup
function.

Arguments
bt err code variable to store BioTac error information

Return Value
This function does not return any value.

Specific Error Codes
None.

Details
This function prints out "Wrong BioTac number assigned!" if wrong bt _select numberis
assigned tothe bt cheetah get properties function. For
BT MAX BIOTACS PER CHEETAH = 3, thisvalue should be integer 1, 2, or 3. For
BT MAX BIOTACS PER CHEETAH = 5, thisvalue should be integer 1,2, 3, 4, or 5.

This function prints out "No BioTac detected!" if no BioTac is detected. A physical connection error
or wrong timing of SPI sampling commands will cause this error.

This function prints out "Wrong maximum number of BioTacs assigned (should be 3 or 5)!" if
BT MAX BIOTACS PER CHEETAHis not 3 or 5. The assigned value should be 3 or 5 only.

This function prints out "The number of samples is too small!" if variable
length of data in secondis too small. It should be greater than 50ms.

This function prints out "Something wrong occurred!" if an unknown error has occurred.

Save data (bt_save_data)

void bt save data ( const char *file name,
const bt data *data,
int num_samples) ;

Save BioTac data, including batch, frame, and channel ids, raw values, parity check, etc.

Arguments
file name pointer of the string of file name such as “output.txt”
data pointer to access the BioTac data
num_samples numbers of sampling data saved into the file

Return Value
This function does not return any value.
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Specific Error Codes
None.

Details
This function saves data in a text file whose name is file name. By default, a saved data format is

as follows (when MAX BIOTACS PER CHEETAH = 3):
time, batch index, frame index, channel id, value[0], bt parity[0],
value[l], bt parity[l], value[2], bt parity[2]

Note that channel idissaved as integer (0-3, 15-35) by default, or can be string (PAC, PDC, TAC,
TDC, HAL, E01-E19) as an option. The string name is declared as command name[] inbiotac.c.

Close Cheetah Device (bt_cheetah_close)
void bt cheetah close (Cheetah ch handle);

Disable the SPI output and close the Cheetah Device.

Arguments
ch _handle handle of a Cheetah adapter

Return Value
This function does not return any value.

Specific Error Codes
None.

Details
Disable the outputs. Close the connection of the Cheetah given by the handle.

4 Error Codes

Literal Name Value
BT OK 0
BT WRONG NUMBER ASSIGNED -1
BT NO BIOTAC DETECTED 2

BT WRONG MAX BIOTAC NUMBER [ -3

BT DATA SIZE TOO SMALL -4

BT ERROR_UNKNOWN COMMAND -5
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5 Code Example

The code example is compatible with Linux (recommended), Mac OS X, and Windows.
Before testing the code, we highly recommend the user try some code examples
provided for a Cheetah SPI adapter. Make sure if you have downloaded an
appropriate USB driver for your operating system and placed an appropriate Dynamic
Linked Library (cheetah. so for Linux and Mac OS X and cheetah.dl1 for
Windows) in a designated directory. Without being able to run Total Phase’s detect
program, our code example will not run properly.

The cross-platform example package contains seven files:
* Dbiotac.c
* biotac.h
¢ cheetah.c
¢ cheetah.h
* example.c
* Makefile

® Makefile-32bit

It is anticipated that the user only modifies example. c. SynTouch LLC does not
provide official support for any modifications on biotac.h, biotac.c, cheetah.h,
or cheetah. c. Therefore, only example. c is explained below.

42  int main(void)

43 |

45 /* --- Define variables --- */

47 bt_info biotac;

48 bt_property biotac_property[MAX_BIOTACS_PER_CHEETAH];

49 bt_data *data;

50 BioTac bt_err_code;

51 Cheetah ch_handle;

52

53 inti;

54 int length_of_data_in_second;

55 int number_of_samples;

56 int number_of_loops;

57

59 /* - Initialize BioTac settings (only default values are supported) --- */
61 biotac.spi_clock_speed = BT_SPI_BITRATE_KHZ_DEFAULT;

62 biotac.number_of_biotacs = 0;

63 biotac.sample_rate_Hz = BT_SAMPLE_RATE_HZ_DEFAULT;

64 biotac.frame.frame_type = 0;

65 biotac.batch.batch_frame_count = BT_FRAMES_IN_BATCH_DEFAULT;
66 biotac.batch.batch_ms = BT_BATCH_MS_DEFAULT;
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67

68 // Set the duration of the run time

69 length_of_data_in_second = 3;

70 number_of_samples = (int)(BT_SAMPLE_RATE_HZ_DEFAULT * length_of_data_in_second);
71

72 // Check if any initial settings are wrong

73 if (MAX_BIOTACS_PER_CHEETAH != 3 && MAX_BIOTACS_PER_CHEETAH !=15)
74 {

75 bt_err_code = BT_WRONG_MAX_BIOTAC_NUMBER;
76 bt_display_errors(bt_err_code);

77 exit(1);

78 }

79

81 /* - Initialize the Cheetah devices --- */

83 ch_handle = bt_cheetah_initialize(&biotac);

84

86 /* --- Get and print out properties of the BioTac(s) --- */
88 for (i=0; i < MAX_BIOTACS_PER_CHEETAH; i++)

89 {

90 bt_err_code = bt_cheetah_get_properties(ch_handle, i+1, &(biotac_propertyli]));
91

92 if (biotac_propertyl[i].bt_connected == YES)

93 {

94 (biotac.number_of_biotacs)++;

95 }

96

97 if (bt_err_code)

98 {

99 bt_display_errors(bt_err_code);

100 exit(1);

101 }

102 }

103

104 // Check if any BioTacs are detected

105 if (biotac.number_of_biotacs == 0)

106 {

107 bt_err_code = BT_NO_BIOTAC_DETECTED;

108 bt_display_errors(bt_err_code);

109 return bt_err_code;

110 }

111 else

112 {

113 printf("\n%d BioTac(s) detected.\n\n", biotac.number_of_biotacs);
114 }

115

116 // The programs stops here until it accepts [Enter] key hit
117 printf("Press [Enter] to continue ...");

118 fflush(stdout);

119 getchar();
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120

122 /* --- Configure the save buffer --- * /

124 data = bt_configure_save_buffer(number_of_samples);

125

127 /* --- Configure the batch --- */

129 bt_err_code = bt_cheetah_configure_batch(ch_handle, &biotac, number_of_samples);
130 if (bt_err_code < 0)

131 {

132 bt_display_errors(bt_err_code);

133 exit(1);

134 }

135 else

136 {

137 printf("\nConfigured the batch\n");

138 }

139

141 /* --- Collect the batch and display the data (if desired) --- */

143 number_of_loops = (int)(number_of _samples / ((double)(biotac.frame.frame_size *
biotac.batch.batch_frame_count)));

144 printf("Start collecting BioTac data for %d second(s)...\n", length_of_data_in_second);
145 for (i=0; i < number_of_loops; i++)

146 {

147 // To print out data on Terminal, set the fourth argument to YES (NO by default)
148 bt_cheetah_collect_batch(ch_handle, &biotac, data, NO);

149 }

150

152 /* --- Save data --- */

154 bt_save_buffer_data("output.txt", data, number_of_samples);

155

157 /* --- Close and exit --- */

159 printf("Press [Enter] to close the program");

160 fflush(stdout);

161 getchar();

162

163 free(data);

164 bt_cheetah_close(ch_handle);

165

166 return O;

167 }

The main function for the example starts from Line 42. First, several variables are
declared (Lines 47-56). Member variables of bt info biotac are initialized (Lines
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61-66). We suggest the user use the default values. On Lines 69-70, the user can change
the duration of the run time. The Cheetah initialization function is called on Line 83. In
the current version of software, if more than one Cheetah devices are hooked up to a
computer, the device opening through port 0 will be detected and other devices will be
ignored. Next, properties of the BioTacs such as flex circuit version, software version,
serial number, and CPU speed and the number of connected BioTacs are displayed on
the display (Lines 88-102). If no BioTac is detected, the program exits (Lines 105-114).
The program waits before configuring the batch until it accepts a user input of [Enter]
key from a keyboard (Lines 117-119).

After the [Enter] key hit, we allocate memory for a buffer to save data (Line 124),
followed by a function to configure batch settings (Lines 129-138). If the user is willing
to try the MACHINE TIMER option, the timer will start here. Thus, pausing after the
bt cheetah configure batch function before stopping collecting data is likely
to cause an error.

Next, we start collecting the batch of data (Lines 143-149). number of loops can be
calculated based on number of samples, frame size, and

batch frame count. During data collection, if the user would like to display
real-time data on Terminal, the fourth argument of bt cheetah collect batch
can be changed from NO to YES. However, keep in mind that printing data on Terminal
makes the program running slower and thus the program might fail to keep up with a
specified clock. Instead, you can save data to a text file using the bt save data
function (Lines 154).

Finally, we close the program by calling bt cheetah close and free allocated
memory.

0S Specific Instructions and Known Issues

Linux

We have tested our code on Ubuntu 10.04 (32-bit and 64-bit). Makefile is written for
a 64-bit kernel. For 32-bit, please delete Makefile (or rename it to
Makefile-64bit)andrename Makefile-32bit toMakefile. Torunthe
example program, fist launch Terminal, move to an appropriate directory, build the
project, and run the executable file:

>> cd /path/to/code example/

>> make
>> . /bin/example
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Make sure if you copy an appropriate version of cheetah. so in a designated folder
(i.e. where your source files are).

MacOS X

We have tested our code on Mac OS X 10.7 (64-bit). First, make sure if XCode 4 or higher
is installed on your machine to run make. Then, follow the instructions for Linux.

Windows

We have tested our code using Microsoft Visual C++ 2010 Express on Windows 7
Professional (64-bit). First, create a new project (File -> New -> Project...)and
choose Empty Project from Visual C++ template. Enter names of the
project/solution and set the location, and click OK. After successfully creating the new
project, right-click on Header Files on the left menu, choose Add ->Existing
item. .. toimportbiotac.h and cheetah.h. Similarly, right-click on Sources
Files and choose Add ->Existing item... toimportbiotac.c, cheetah.c,
and example. c. Make sure if you copy an appropriate version of cheetah.dllina
designated folder. In our case, we downloaded the 32-bit version of cheetah.dl1l
and copied itto C: \Windows\System32 because Microsoft Visual C++ Express 2010
runs under the 32-bit mode.

We have observed that when print flag, the fourth argument of the

bt cheetah collect batch function, is set to YES, only the first batch collects
BioTac data. Thus, it is highly recommended that Windows users turn off the print
display feature. A member variable parity checkinbt data cab be a quick check
if collected data are corrupted.
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6 Revision History

(V1.1.0) April 5, 2012
¢ Compatible with BioTac firmware 2.x.x and 3.x.x
* New function bt configure save buffer created
* Due to structure change, bt property is not a member variable of bt info

(V1.0.0) December 22, 2011
Original document created
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